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This brief guide provides examples in the APA style for 
information sources most commonly used by DMACC 
students. It should always be used in conjunction with 
the 6th edition of the Publication Manual of the 
American Psychological Association and information 
provided by DMACC instructors. Appropriate page 
numbers from the handbook are documented with 
each example in this guide. You may also want to visit 
the APA website at http://www.apastyle.org/. 
Finally, don’t forget—your librarians are always ready 
to help with citation questions! 

The 7th edition of the Publication Manual of the 
American Psychological Association makes a 
distinction between student and professional papers. 
This guide outlines  guidelines for student papers. 

 

How can this guide help me? 

Any academic research project must include accurate 
documentation of the resources consulted. This means 
providing information about your sources so your 
reader can locate them. If you examine articles in 
research journals, you’ll notice that they always 
include a list of references, with publication 
information.  

Documentation in research projects has two basic 
features: 

1. References List: At the end of your paper or 
presentation, include a list of the resources you 
used. The list must be on a separate page at the 
end of your paper with the title “References” 
centered at the top of the page. Each entry, or 
citation, in the list provides information about the 
individual source. Citations are listed in 
alphabetical order, starting with the author’s last 
name. If a source has no author, the entry is 
alphabetized by title. Citations are double-spaced 
with hanging indents. There are specific rules for 
punctuation and italics in a References List, 
illustrated by the examples in this guide.  

2. In-Text References: Each time you refer to a 
source in the text of your paper, include the last 
name of the author or the first few words of the 
title of the source (enough to identify it in your 
list of References) and the publication date, as 
close to the paraphrase or quotation as possible. 
(See the section on In-Text References for 
examples.) These references lead your reader to 
the appropriate entry in your References List.  

Why do citation styles matter? 
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Formatting Your Paper 
Microsoft Word 

What should my final paper look 
like? 

The APA Handbook recommends that student papers 
adhere to certain formatting guidelines. Be sure to 
check with your instructor to verify these guidelines 
with his/her own preferences and requirements. Use 
this document as a tool to create basic research papers.  
More complicated papers may require additional 
resources. 
 
APA-style papers should include four major components: 

1. Title page 
2. Page numbers 
3. Text 
4. References page 

 
Student papers do NOT include a running head, an 
author note, or an abstract unless specifically required 
by the instructor.  
 
General Formatting Guidelines 

 Type your paper on a computer and print it on 
standard, white 8.5x11-inch paper. 

 Double-space the text of your paper and use a 
legible font like 12-point Times New Roman. 

 Set the margins of your document to 1 inch on all 
sides. 

 Indent the first line of all body paragraphs by 1/2 
inch. 

 Include a header that includes the page numbers 
at the top right on every page. 

 
 
 

How do I format my paper in 
Microsoft Word? 

Open a new Microsoft Word document  

A new document automatically appears when Word is 
opened. 

Create a new blank document  

1. Open Word 2013/2016.  

2. Single-click the Blank document option.  

Shortcut Option: Press <Ctrl> + <N>  in Microsoft Word 
to open a new blank document. 
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Formatting Your Paper 
Microsoft Word  

Set your margins to 1 inch 

A margin is the empty space between a document’s 
contents and the edges of the page. Word’s default 
margins are 1 inch on each side of the page which is 
also the required margin for APA.  However, if the 
default is not 1 inch, you can easily adjust the margins.  

1. Click the Page Layout tab on the Ribbon and click 
the Margins button in the Page Setup group.  
 
A list of common page margins appears.  

2. For 1 inch margins, select the Normal margin 
setting.  
 
The margin setting is applied to the document.  

Note: This is the normal default for margin spacing 
for all versions of Word that you obtain/use through 
DMACC. 

Set your line spacing and indentation  

The default settings for 
Word 2013/2016 do not 
match the APA style 
requirements for line 
spacing and indentation, 
so you will need to make 
the following 
adjustments. 

1. Click the Home tab 
on the Ribbon and 
click the Line 
Spacing button in 
the Paragraph 
group.  

2. Click Line Spacing 
Options.  

3. Make the following changes: 

 

 

A. Change Indentation to 
First line by .5”. 

B. Change After spacing to 0pt. 

C. Change Line spacing to Double. 
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Formatting Your Paper 
Microsoft Word 

Create your header 
In APA style, only the page number should appear 
at the right top margin in the header.   

1. Click the Insert tab on the Ribbon and select 
Header from the Header & Footer group. Scroll 
down to the bottom of the list and select Edit 
Header. 

2. Click on Home in the Ribbon and click on the 
Right Align tab.  

3.   Click on the green Header & Footer Tool 
Design box at the top of the screen. 

4.    Click the Page Number tab. 

5. Slide your cursor down to Current Position 
and then over to Plain Number. 

8. Press the Close Header and Footer button in 
the ribbon and return to your paper. 
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Title Page 
Microsoft Word  

Learning to be Information Literate in the Information Age 

 

A. Sample Student 

Des Moines Area Community College 

SDV171: Library Instruction 

My Instructor’s Name 

Feb. 12, 2020 

     1 

Sample title page 

How do I format my title page?  
APA style requires a separate title page for 
student papers, which includes the title of the 
paper, the author’s name, and the institution for 
which the paper has been written.  The title will 
be typed with mixed case letters, centered, and 
positioned in the upper half of the page. 

1. Bold. Type the title of the research paper at 
the top of the title page. Press Enter twice. 
Unbold. 

2. Type the name of each author. Press Enter. 

3. Type Des Moines Area Community College. 
Press Enter. 

4. Type the course number, immediately 
followed by a colon. Type one space and then 
the course name. Example: ENG105: 
Composition 1, Press Enter. 

5. Type your instructor’s name. (Please check for 
their preferred format. Press Enter. 

6. Assignment due date, written in the “normal” 
American style. Example: April 4, 2020. 

Center the text horizontally 

1. Highlight the text to be centered. 

2. Click the Center alignment button in the 
Paragraph group on the Home tab, or press 
Ctrl + E. 

Position the text vertically 

APA style says the title should be positioned in 
the upper half of the page.  APA recommends 3 or 
4 lines down from the top of the page.  

When your title page is complete, press 
<ctrl><enter> to advance to the next page. Make sure that you use the same font through-

out your paper, including your header and 
your References list. 
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Formatting Your Paper 
Microsoft Office 365 

What should my final paper look 
like?  

The APA Handbook recommends that student papers 
adhere to certain formatting guidelines. Be sure to 
check with your instructor to verify these guidelines 
with his/her own preferences and requirements. Use 
this document as a tool to create basic research papers.  
More complicated papers may require additional 
resources. 
 
APA-style papers should include four major components: 

1. Title page 
2. Page numbers 
3. Text 
4. References page 

 
Student papers do NOT include a running head, an 
author note, or an abstract unless specifically required 
by the instructor.  
 
General Formatting Guidelines 

 Type your paper on a computer and print it on 
standard, white 8.5x11-inch paper. 

 Double-space the text of your paper and use a 
legible font like 12-point Times New Roman. 

 Set the margins of your document to 1 inch on all 
sides. 

 Indent the first line of all body paragraphs by 1/2 
inch. 

 Include a header that includes the page numbers 
at the top right on every page. 

Go to http://my.dmacc.edu. Login using your 
DMACC username/password.  

Select Office365. 

 

How do I format my paper in 
Office365? 
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Formatting Your Paper 
Microsoft Office 365 

Select Word from the list of available programs. 

Single click the New Blank Document tile 

 

Name your file 

Office365 will automatically save your file to 
your OneDrive account. However, it will simply 
call it “Document”, which is not very useful.  

1. Single click on  “File” 

2. Single click on “Save As” 
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Formatting Your Paper 
Microsoft Office 365 

3. Single click on “Save As” 

4. Give your file a name that makes sense.  

Check “Replace existing 
file” to avoid having 
multiple files called 

“Document” 

Set your line spacing and indentation  

The default settings for Office365 do not 
match the APA style requirements for line 
spacing and indentation, so you will need to 
make the following adjustments. 

 

 
 
 
 
 
 
1. Your margins will default to 1”. 
2. Click the “Page Layout” tab. 
3. Click the small arrow in the Paragraph 

group. 

4. Set “Spacing” both Before and After to 
0.00”. 

5. Change “Line Spacing” to “Double”. 
6. Click “Ok”. 
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Formatting Your Paper 
Microsoft Office 365 

Create your header 

In APA style, only the page number should appear 
at the right top margin in the header.   

1. Click the “Insert” tab and click “Header and 
Footer”.  

2.   Click the Page Numbers button and then 
select the image with the page number in the 
upper right-hand corner. 

3. Click “Edit in Browser” to close the Header & 
Footer tools and return to your document.  

How do I format my title page?  
APA style requires a separate title page for stu-
dent papers, which includes the title of the paper, 
the author’s name, and the institution for which 
the paper has been written.  The title will be 
typed with mixed case letters, centered, and posi-
tioned in the upper half of the page. 

1. Bold. Type the title of the research paper at 
the top of the title page. Press Enter twice. 
Unbold. 

2. Type the name of each author. Press Enter. 

3. Type Des Moines Area Community College. 
Press Enter. 

4. Type the course number, immediately followed 
by a colon. Type one space and then the 
course name. Example: ENG105: Composition 
1, Press Enter. 

5. Type your instructor’s name. (Please check for 
their preferred format. Press Enter. 

6. Assignment due date, written in the “normal” 
American style. Example: April 4, 2020. 

Center the text horizontally 

1. Highlight the text to be centered. 

2. Click the Center alignment button in the Para-
graph group on the Home tab, or press Ctrl + 
E. 

Position the text vertically 

APA style says the title should be positioned in the 
upper half of the page.  APA recommends 3 or 4 
lines down from the top of the page.  

When your title page is complete, press 
<ctrl><enter> to advance to the next page. 
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Sample Title Page 

Learning to be Information Literate in the Information Age 

 

A. Sample Student 

Des Moines Area Community College 

SDV171: Library Instruction 

My Instructor’s Name 

Feb. 12, 2020 

     

Sample title page 

Make sure that you use the same font through-
out your paper, including your header and 
your References list. 
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Body  

The body of the paper, or the content of the paper 
should start with the title of the paper in bold and 
centered at the top with the rest of the content double-
spaced with first-line indented paragraphs.  See Set 
your line spacing and indentation on page 3 for 
instructions in Microsoft Word. 

APA Style allows you to use any font that is accessible 
to readers. Many fonts are available, however, 
recommended fonts include:  

 11 point Calibri 

 11 point Arial 

 10 point Lucida Sans Unicode 

 12 point Times New Roman 

 11 point Georgia 

Instructors: APA recommends using word count rather 
than page count to set paper length. Due to varying 
sizes of different fonts, this is a more accurate way of 
gauging paper length. 

How do I format the body of my 
paper? 

Learning to be Information Literate in the Information Age 

          Research text Research text Research text Research text Research text Re-

search text Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research text 

Research text Research text Research text (Baldwin, 2007). 

          Research text Research text Research text Research text Research text Re-

search text Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research text. 

Research text Research text Research text Research text Research text Research text 

(Levin, Kater, & Wagoner, 2006). Research text Research text Research text. 

          Research text Research text Research text Research text Research text Re-

search text Research text Research text Research text Research text Research text 

Research text Research text Research text Research text Research text Research text.  

     3 
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In-Text References 

What are in-text references 
and how do I use them?  

Within the text of your paper, you must show your 
reader exactly what you borrowed from each source 
you paraphrase or quote, and exactly where in the 
source you found the material. These are your in-
text, or parenthetical, references.  
 
Your in-text references must clearly point to sources 
in your References list, except in the case of 
personal communications (discussed later). Usually 
the author's last name and the publication date is 
enough. In some cases, such as when citing from a 
book, you will need to include page numbers as well. 
If a source has no author, use the title, shortened or 
in full. 
 
The following original passage is from the book 
Research Strategies, 5th edition, page 19 by 
William Badke, published in 2014 by iUniverse.  
The examples show different types of in-text 
references. 
 
Citation 
 
Badke, W. (2014). Research strategies. 

Bloomington, IN: iUniverse. 

 
 
 

Direct Quotation: 
 

"When Dorothy from the Wizard of Oz discovered 
she was now in the Land of Oz, she told her dog 
Toto, ‘We’re not in Kansas anymore.’ If you’ve 
recently come into (or come back to) education, one 
of the first things to recognize is that this isn’t 
Kansas, this is Academia. It has new rules, new 
players, new sources of information and new ways 
of doing research" (Badke, 2014, p. 19). 
 

Paraphrase with the author’s 
name in the parenthetical 
reference: 
 
Much like when Dorothy discovered she had arrived 
in the Land of Oz, this is not Kansas. This is 
Academia, and everything has changed (Badke, 
2014, p. 19). 

Direct quote with the author’s 
name in the text: 
 

Badke (2014) goes on to say “one of the first things 
to recognize is that this isn’t Kansas, this is 
Academia. It has new rules, new players, new 
sources of information and new ways of doing 
research" (p. 19). 
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Paraphrase with the author’s 
name in the text: 
 
Badke (2014) makes the analogy that, like when 
Dorothy discovered she had arrived in the land of 
Oz, this is not Kansas anymore. This is Academia, 
and everything has changed (p. 19). 

In-Text References 

References with three (3) or 
more authors 
 
When you are citing or paraphrasing a work with 
three or more authors, you should list the last 
name of the first author, followed by “et al.”, the 
copyright date, and the appropriate page number. 
 
“Evolution depends on the creation of new genes, 
as well as on the modification of those that 
already exist” (Alberts et al., 2008, p. 253). 
 
 

Indirect reference: 
 
Sometimes, you will need to refer to an indirect 
quotation, that is, something that was itself a 
quotation in one of your sources. In this case, put 
the phrase “as cited in” before the reference.  

Joan London wrote of her father, Jack, “His longing 
for his daughters was deep and true, his need for 
them was desperate. But did anyone ever bungle 
more badly in trying to realize that desire?” (as 
cited in Labor, p. 336). 

This could also be written with both sources listed 
in the text. 

Labor cites Joan London as saying of her father, 
Jack, that “his longing for his daughters was deep 
and true, his need for them was desperate” (p. 
336) . 

You should only include the book, article or Web 
site that you actually have on your References 
page. In this example, Joan London would not be 
included on the References page. 

APA discourages the use of indirect quotations. 
They suggest that whenever possible, you should 
attempt to acquire the original document.  

Labor, E. (2013). Jack London: An American life. 

New York, NY: Farrar, Straus & Giroux.  

Reference with no author: 
 
When a source does not include an author, it is 
necessary to refer to it in your text by the full 
title (if short), or the first few words of a longer 
title. Begin with the word by which the source is 
alphabetized in your References list. 
 
For example, a quote from the entry “Plagiarism” 
from Wikipedia might read: 
“Within academia, plagiarism by students, 
professors, or researchers is considered academic 
dishonesty or academic fraud, and offenders are 
subject to academic censure, up to and including 
expulsion” (Plagiarism, 2014).  
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In-Text References/DOI 

Personal Communications 

In APA style, the list of references includes information about recoverable data only. Personal communications 

are not recoverable by your reader, so they are cited only in the text of your paper. APA refers to these as “No 

source”. Examples of times when you have “no source” include such things as interviews, email, phone 

conversations, and classroom lectures. When you refer to personal communications, give the initials and last 

name of your source, a descriptive phrase describing the communication, and as exact a date as possible. For 

example: 

 

According to librarian P. Mumma (personal communication, September 17, 2014), students can get help finding 

information for research projects in several ways. 

 

DMACC students can get help for research projects in person, by phone, email, or from the library website (P. 

Mumma, email, January 29, 2020). 

What is a DOI?  

DOI stands for Digital Object Identifier. It is a string of numbers and letters that serve as a permanent “address” 
to digital objects such as journal articles. URLs (web addresses) are constantly changing, and are, therefore, not a 
particularly effective way to relocate digital information. Since DOIs never change, they should always lead users 
back to the original document. Using a DOI instead of a URL in a reference list prevents users from encountering 
broken links and dead ends when recovering sources from a reference list. 

DOI is administered by the International DOI Foundation. Individual documents (articles and sometimes books) 
are assigned DOIs by the publisher at the time of publication. Once assigned, they will never change. A DOI will 
link readers directly to the object in question (or information about how to access the object) no matter where the 
object currently resides or how many times it has been moved. DOIs are also independent of database vendors, 
meaning that if an individual article or journal is indexed in multiple databases, it can be retrieved in all of them 
using the same DOI. 

CrossRef.org is a website that helps researchers and students check existing and locate missing DOIs. Use their 
website (www.crossref.org) to look up a DOI for an article, to verify an article’s DOI, or to find an article using its 
DOI.  

In APA references lists, DOI takes the place of changeable resource information (such as URLs). It eliminates the 
need for retrieval dates. Use DOI information whenever available, both for electronic resources and print 
resources.  
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DOI 

APA provides the following guidelines for using DOIs and URLs in references. 

 If a work has a DOI, use it. It doesn’t matter if you used the print or online version, you should always use 
the DOI, if it is available. 

 If you are using a printed source, and it does not have a DOI, do not include any DOI or URL in the 
reference 

 If an online work has both a DOI and a URL, include only the DOI 

 If an online work has a URL but no DOI, include the URL under the following conditions: 

 “Normal” websites (not library databases), include the URL as long as it will lead readers to your 
source. Remember: APA does allow the use of shortened URLs. 

 If the source came from a library database and does not have a DOI, do NOT include a URL or 
database information in your References list.  The reference should be the same as the 
reference for a print version of the work.  

 DOIs should be listed as hyperlinks. This means that if your reader clicks on the link, it should take them 
to your resource.  

 DOIs should be in the following format: https://doi.org/whateverthedoiis 

 Older articles may list the DOI in a slightly different format. You should use the current formatting 
for your DOI 

 DOIs and URLs should not have a period at the end as this may interfere with retrieval 

 If your source has a particularly long DOI, the International DOI Foundation provides a DOI shortner (like 
a URL shortner, but for DOIs), at http://shortdoi.org 

If you have questions about DOIs and using them in your References list, you may contact a DMACC librarian 
for assistance.  
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Gender & Personal Identification 

 

Names  
Use the name the individual uses to identify 
themselves. This may or may not be their legal 
name and/or birth name.  

Pronouns  
Use the individual’s identified pronouns (whether 
you agree or not). If you are not sure of their 
pronouns, use the singular they/them/theirs.  
Do NOT use the term “preferred pronouns”. This 
implies that there is a choice. Instead, use the 
term “identified pronouns” or just “pronouns”. 

Identifiers 
Be as specific with identifiers as possible. When 
possible, prefer terms like cis men, transgender 
women, gay men, etc. over simple “Men” and 
“women”.  

Abbreviations are acceptable, but should be as 
representative of the groups being described as 
possible. LGBT is outdated. No common 
replacement has yet been agreed upon.   

Acceptable umbrella terms include “sexual and 
gender minorities” or “sexual orientation and 
gender diversity”.  

Use male/female when appropriate.  
Acceptable: Assigned female at birth 
Unacceptable: Born a girl 

Opposite Sex 

Avoid the term “opposite sex”. It implies that 
gender is binary. It also implies that the genders 
are more different than alike. Use the term 
“another sex”.  

Use the term “mixed gender” or “mixed sex” when 
referring to romantic relationships of individuals of 
differing genders or sexes. 

Use the term “same gender” or “same sex” when 
referring to romantic relationships of individuals of 
the same gender or sex.  

They/Them/Theirs 
Avoid the use of s/he, (s)he, etc. This is distracting to the reader, and it implies that gender is generic and 
interchangeable. It implies that gender is binary, with only two options.  

When referring to an individual who’s gender is unknown, or when using a hypothetical where gender does 
not matter, use the singular They/Them/Theirs. Bias occurs when He/Him/His is applied to all individuals. 
Alternating between He/Him/His and She/Her/Hers implies that gender is both binary and 
interchangeable. Even when attempting to be generic, gender specific pronouns cause people to think of 
specific genders in that role. For example, referring to nurses as “she” will cause most individuals to 
mentally place a female into the role of nurse.  
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References Page 

The References page includes an alphabetical 
list of the sources you cited in your paper.  
The References section of this guide provides 
examples of how to format citations for books, 
articles, DMACC Library Databases, and Web 
Sites.  You can also see the Using Citation 
Tools section of this guide for instructions on 
how to build a References page in NoodleTools 
or Microsoft Word. 

The page layout of your References page uses 
the same 1 inch margins, double-spacing, and 
header as the body of the paper.  However, 
the page should be titled References, and the 
individual citations will use a hanging indent. 

Create a hanging-indent in Microsoft Word 
2013 

1. Place your cursor on the first line after the 
References header, or highlight your 
citations if they are already typed. 

 

 

 

2.   Click the Home tab on the Ribbon and  
click the Line Spacing button in the 
Paragraph group.  

3.  Click Line Spacing Options.  

4.   In the Indentation area, select Hanging 
by .5” under Special. 

 

 

 

5. Press OK. 

Formatting a References page What is a References page?  

The Publication Manual of the American Psychological 
Association states: 

References acknowledge the work of previous 
scholars and provide a reliable way to locate it. 
References are used to document statements 
made about literature, just as data in the 
manuscript do not need to be exhaustive but 
should be sufficient to support the need for 
your research and to ensure that readers can 
place it in the context of previous research and 
theorizing. 
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Sample References Page 

References  

Bennett, K. K., Behrendt, L. S., & Boothby, J. L. (2011). Instructor perceptions of 

plagiarism: Are we finding common ground? Teaching of Psychology, 38(1), 29-35. 

doi:10.1177/ 0098628310390851 

Cvetkovic, V. B., & Anderson, K. E. (Eds.). (2010). Stop plagiarism: A guide to 

understanding and prevention. Neal-Schuman. 

Plagiarism prevention: A guide for students. (2012). Retrieved August 16, 2020, from 

http://www.deltastate.edu/ pages/ 1268.asp 

Youmans, R. J. (2011). Does the adoption of plagiarism-detection software in higher 

education reduce plagiarism? Studies in Higher Education, 36(7), 749-761. 

doi:10.1080/ 03075079.2010.523457 

                                                                        4 
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Overview & Books 

Book with one author or editor  
Morest, V. S. (2013). Community college student 

success: From boardrooms to classrooms  Rowman 

& Littlefield. 

Parenthetical citation: (Morest, 2013) 

Narrative citation: Morest (2013) 

 

Ruan, K., (Ed.). (2013). Cybercrime and cloud forensics: 

applications for investigation processes. 

Hershey, PA: Information Science Reference. 

Parenthetical: (Ruan, 2013) 

Narrative: Ruan (2013) 

APA identifies four elements needed for a 
reference:  

 Author's or editor's name (last name, initial(s)),  
 Date of publication, in parentheses 
 Title (italicized). Capitalize the first word in 

title and subtitle and all proper nouns. 
 Source 

                                                                                                                                                                                              
It’s usually best to take this information from the title 
page of the book (front and back) rather than the 
cover. 
 
Sometimes, you need to include additional 
information, such as the edition of the book or the 
specific pages you are citing. 

Overview 

Republished book, ebook or 
audiobook 
Rowling, J.K. (2012). Harry Potter and the sorcerer’s stone.  

(J. Dale, Narr.) [Audiobook]. Pottermore Publishing. 

https://bit.ly/2YHiucI (Original work published 1997) 

Parenthetical:  (Rowling, 1997/2012) 

Narrative: Rowling (1997/2012) 

Books 

eBook or audiobook 
Obama, M. (2018). Becoming (M. Obama, Narr.). Crown. 

https://bit.ly/2LT5Imj 

Parenthetical:  (Obama, 2018) 

Narrative: Obama (2018) 

Shreve, A. (2007). Body Surfing [Audiobook]. Little Brown. 

https://bit.ly/353BxAk 

Parenthetical: (Shreve, 2007) 

Narrative: Shreve (2007) 

 APA DOES allow the use of shortened URLs, as long as 

you check to make sure they work. (Some shortened 

URLs have a temporary life span. You may want to use 

Bitley or Tiny URL to avoid this issues.) 

 If the content is identical to the print version, there is 

no need to note when you use an audiobook or ebook.If 

the content is different, note it in the title element.  

 If an audiobook is released in a different year than the 

text version, treat it as a republished work.  
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Books 

Multiple authors 
Two authors or editors. 

Sepulvaeda, S. & Graham Scott, G. (2017). At death’s door: 

End of life stories from the bedside. Rowman & 

Littlefield 

Paranthetical: (Sepulveda & Graham Scott, 2017) 

Narrative: Sepulveda & Graham Scott (2017)  

Gonzales, J. J. & McGee, M. P. (Eds.). (2019). Legal 

marijuana: Perspectives on public benefits, risks 

and policy approaches. McFarland. 

Paranthetical: (Gonzales & McGee, 2019) 

Narrative: Gonzales & McGee (2019) 

Three to 20 authors or editors. 

Author A. A., Author B. B., Author C. C., Author D. D., 

Author E. E., Author F. F., & Author J. J. (Year). 

Title of work. Location: Publisher.  

Roach, M., Waterman, N., & Morrison, J. (with Coulthard, 

D.) (2018). The science of supercars: Including 

interviews with the biggest names in supercar 

design. Firefly. 

Paranthetical: (Roach et al., 2018) 

Narrative: Roach et al. (2019) 

 

For 2 up to, and including, 20 authors, list them all on 

your References page, and use an ampersand (&) for the 

last author’s name. If a non-primary author is credited, 

include them in the entry in parentheses using the word 

“with” 

Book with a corporate author 
American Psychological Association. (2019). Publication 

manual of the American Psychological Association 
(7th ed.). https://doi.org/10.1037/0000165-000 

Parenthetical: (American Psychological Association, 2019) 
Narrative: American Psychological Association (2019) 

Second or later edition of a book 
Badke, W. (2014). Research strategies. (5th ed.). 

iUniverse. 

Parenthetical: (Badke, 2014) 
Narrative: Badke (2014) 

Book chapter or anthology 
McClenney, B. (1997). Launching a learning college. In T. 

O’Banion (Ed.), A learning college for the 21st 
century (pp. 211-224). Oryx Press.  

Parenthetical: (McClenney, 1997) 
Narrative: McClenney (1997) 
 

Encyclopedia or Dictionary 
O'Banion, T. U. (2006). Community college. In World book 

encyclopedia (Vol. 4, pp. 898-899). World Book. 
Paranthetical: (O’Banion, 2006) 
Narrative: O’Banion (2006) 
This is a printed work. 

coronavirus. (2018). In P. Lagasse, & Columbia 
University, The Columbia encyclopedia (8th ed.). 
Columbia University Press.  

Paranthetical: (coronavirus, 2018) 
Narrative: coronavirus (2018) 
This is from the Credo reference database. 
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Articles 

Citations for articles and other documents from subscription 
services databases will normally include the same 
information you would have in a citation to a print source, 
plus the document’s DOI information. You do not have to 
include information about which database you used to find 
the article, or when you first retrieved it. The basic 
elements of a citation for an online article include the 
following: 
 
 The author's name (last name, intial(s)) 

 The year of publication, in parenthesis 

 The title of the article. Capitalize the first word in title 
and subtitle and all proper nouns. 

 The name of the periodical (italicized) 

 The volume number (if known), in italics 

 The page numbers of the article 

 The digital object identifier (DOI), if available 

 If no DOI is included, use CrossRef (www.crossref.org) 
to try to look up the DOI information for the article.  If 
CrossRef yields no results, look up the website for the 
journal and include the URL in your citation. Do not 
look for the specific page containing the article; only 
include the journal’s main or home page. 

 
Note: Some databases will try to provide ready-made 
citations for their resources. Be cautious with these, as 
many are not up to date with the latest APA guidelines, and 
others often contain mistakes. 

What pieces of information do I 
need to cite an article from a 
database?  

Is it a magazine, a journal, or a 
reference book? 

The DMACC databases provide information from a variety of 
sources, including magazines, journals and reference books. 
It’s important to distinguish which type of resource you are 
using.  

Books will often include words like Encyclopedia, Dictionary 
or Survey in the title. A publisher is almost always provided. 
Many times you may see an “ISBN”, which is a code for the 
book. You may see phrases like, “In The Encyclopedia of…” 
Most of the entries in the Credo Reference and Magill 
OnLiterature Plus databases are from books. 

Magazines and journal articles will not list a publisher. They 
will list a “source”, which is the name of the magazine/
journal. It will include a date of publication, which is usually 
listed as a month and year (August 2012). Generally, you will 
also see a volume and issue, which may be identified, or 
may look like a decimal number (132.7). On newer articles, 
you may also see something called a “DOI.” This information 
is important in creating citations using the APA format. 

Journal 
article 

Reference 
book 

Reference 
book 
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Articles 

Newspaper Article 
Rossi, L. (2007, March 5). More high schoolers tackle 

college courses. The Des Moines Register, 1A, 
4A. 

Parenthetical: (Rossi, 2007) 
Narrative: Rossi (2007) 

Online Newspaper Article 

DMACC’s Food Forest sprouts promise (2020, April 30). 
Des Moines Register.  https://
www.desmoinesregister.com/story/news/local/
des-moines/2020/05/01/dmaccs-food-forest-
sprouts-promise/3059048001/ 

Parenthetical: (DMACC’s Food Forest, 2020) 
Narrative: DMACC’s Food Forest (2020) 

What pieces of information do I 
need to cite an article? 

 The author's name (last name, initial(s)) 

 Year and exact date (month or month and date) of 
publication, separated by a comma and placed in 
parenthesis 

 The title of the article. Capitalize the first word in title 
and subtitle and all proper nouns, such as names. 

 The name of the publication in italics 

Scholarly versus popular: What’s 
the difference? 
Traditional popular materials include newspapers and 
magazines, such as The New York Times or People 
magazine. While these publications serve a very important 
purpose, instructors often require students to use scholarly 
resources for their research projects. Journals are the most 
common place to find scholarly information. They include 
articles written by experts that are often reviewed and 
critiqued by other experts before they are published.   

What is a periodical? 
A periodical is any publication that appears on a regular 
basis, such as a daily newspaper, a weekly or monthly 
popular magazine, or a scholarly journal published three or 
four times a year. Articles from periodicals are excellent 
resources for student research projects.  

Article from a News Site 

Holland, O. (2020, May 9). Our cities may never look the 
same again after the pandemic. CNN. https://
www.cnn.com/style/article/cities-design-
coronavirus/index.html  

Parenthetical: (Holland, 2020) 
Narrative: Holland (2020) 

Online vs. print 
In today’s world, most academic researchers gather most of 
their information/data from online library databases. The 
articles contained within these databases are easily 
accessible from a variety of sources. As a result, APA makes 
no distinction in the References for print vs. online sources.  
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Articles 

Journal/Magazine with a DOI 
 
Lingel, J. & Boyd, D. (2013, May).  ‘Keep it secret, 

keep it safe’: Information poverty, 
information norms and stigma. Journal of the 
American Society for Information Science & 
Technology, 64(5), 981-991. https://
doi.org/10.1002/asi.22800  

Mehra, B. (2019, July). The non-white man’s burden 
in LIS education: Critical constructive nudges.  
Journal of Education for Library & 
Information Science, 60(3), 198-207. https://
doi.org/10.3138/jelis.2019-0012 

Journal/Magazine without a DOI 
Roksa, J., & Calcagno, J. C. (2010). Catching up in 
 community colleges: Academic preparation and 
 transfer to four-year institutions. Teachers College 
 Record, 112, 260-288. 

Fiddy on his famous friends. (2020, May 18). People 92(20), 
19. 

New general science findings from University of South 
Africa outlined: (Plagiarism and ghostwriting: 
The rise in academic misconduct). (2016, July 
8). Science Letter, 678.  

Journal/Magazine from a 
website 
Landgraf, G. (2020, May 1). Meeting legal needs: 

Libraries help bridge the justice gap. 
American Libraries. https://
americanlibrariesmagazine.org/2020/05/01/
meeting-legal-needs-libraries-justice-gap/  

Ramazanu, S, Loke, A.Y., & Chiang, V.C.L. (2019, Nov 
16). Couples coping in the community after 
the stroke of a spouse: A scoping review. 
NursingOpen, 7(2). https://doi.org/10.1002/
nop2.413  

Lewis, T. (2020, May 12). How coronavirus spreads 
through the air: What we know so far. 
Scientific American. https://
www.scientificamerican.com/article/how-
coronavirus-spreads-through-the-air-what-we-
know-so-far1/  
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Online Resources 

What pieces of information do I 
need to cite online resources?  
Citations for online resources may include any or all of 
the following: 
 
 The name of the author, compiler, group author 
or editor of the work  
 The publication or update year, if known, in 
parenthesis (If there is no publication date, use the 
abbreviation n.d. in place of the year.) 
 The title of the document, in italics (capitalize 
only the first word of the title and any names of 
people or places) 
 The title of the larger website, if it is different 
from the author. 
 The retrieval statement giving the electronic 
address, or URL, of the site, with no period or other 
additional punctuation 
 
In reality, many websites will not include all of the 
information you would find in a print source or 
subscription database document. If you cannot find 
some of the information, cite what is available.  

Include a retrieval date only if the information is 
designed to change over time and are not archived. 
Examples might include a Facebook page, or Twitter 
profile. Most sites will not require a retrieval date 
since most pages are archived in some manner. 
 

General Website 
Centers for Disease Control and Prevention. (2020, May 13). 

Symptoms of coronavirus. https://
www.cdc.gov/coronavirus/2019-ncov/
symptoms-testing/symptoms.html 

Parenthetical: (Centers for Disease Control, 2020) 
Narrative: Centers for Disease Control (2020)   

Smith, M.W. (2020, May 13). Coronavirus and COVID-
19: What You Should Know.  https://
www.webmd.com/lung/coronavirus  

Parenthetical: (Smith, 2020) 
Narrative: Smith (2020) 

Worldometer. (2020, May 13). Covid-19: Coronavirus 
pandemic. Retrieved May 13m 2020 from 
https://www.worldometers.info/coronavirus/ 

Parenthetical: (Worldometer, 2020) 
Narrative: Worldometer (2020)  
This entry requires a retrieval date. It is a counter 
keeping track of the number of covid-19 cases 
worldwide, and therefore is designed to change 
without being archived.   

Photograph/Clip Art  
Howtostudy.com. (2020) Learning style assessment 

[Photograph]. https://www.how-to-study.com/
learning-style-assessment/  

Parenthetical: (Howtostudy.com, 2020) 
Narrative: Howtostudy.com (2020) 

Gclipart.com (2016). Study clipart: Image (17890) 
[Clip art]. http://gclipart.com/study-
clipart_17890/   
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Web Sites 

Podcast 
Vedantam, S. (Host). (2015-present). Hidden brain 

[Audio podcast]. NPR. https://www.npr.org/
podcasts/510308/hidden-brain 

Parenthetical: (Vedantam, 2015-present) 
Narrative: Vedantam (2015) 
This citation includes the entire series. 

Vedantam, S. (Host). (2020, May 11). All the world’s a 
stage: Including the doctor’s office. [Audio 
podcast episode]. In Hidden Brain. NPR. 
https://
www.npr.org/2020/05/11/853753307/all-the-
worlds-a-stage-including-the-doctor-s-office  

Parentheical: (Vedantam, 2020) 
Narrative: Vedantam (2020) 
This citation is for a single episode 

Social Media 
Trump, D.J. (2020, May 13). As I have said for a long 

time, dealing with China is a very expensive 
thing to do. We just made. [Tweet]. Twitter. 
https://twitter.com/realDonaldTrump?
ref_src=twsrc%5Egoogle%7Ctwcamp%5Eserp%
7Ctwgr%5Eauthor  

Parenthetical: (Trump, 2020) 
Narrative: Trump (2020) 

CBS News. (2020, May 13). U.S. is at the "beginning of a 
long fight," public health expert says — and he 
expects major changes in the. [Status update]. 
Facebook. https://www.facebook.com/CBSNews/  

Parenthetical: (CBS News, 2020) 
Narrative: CBS News (2020) 

American Patchwork & Quilting[@allpeoplequilt]. (2020, 
May 13). Get the look of English paper piecing 
with your sewing machine. Cut fabric 1/4" 
larger than the sticky hexagon templates. 
[Photograph]. https://www.instagram.com/
allpeoplequilt/ 

Parenthetical: (American Patchwork & Quilting, 2020) 
Narrative: American Patchwork & Quilting (2020)  

PowerPoint Slides 
Stevens, A. C. (2020). [Lecture notes on personality 

development]. Blackboard. https://
dmacc.blackboard.com 

Parenthetical: (Stevens, 2020) 
Narrative: Stevens (2020) 

Vanderlinden, D.W. (2020). Slime and you 
[PowerPoint slides]. Blackboard. https://
dmacc.blackboard.com 

Parenthetical: (Vanderlinden, 2020) 

Blog 
Nurse Nacole (2020, May 12). Nursing tip of the day! 

Fundamentals. http://
www.nursenacole.com/  

Parenthetical: (Nurse Nacole, 2020) 
Narrative: Nurse Nacole (2020) 
 

YouTube/Streaming Videos 
ABCNews. (2020, May 13). New coronavirus model 

predicts jump in death toll [Video]. YouTube. 
https://www.youtube.com/watch?
v=jWGMyCtWZ2Q 

Parenthetical: (ABCNews, 2020) 
Narrative: ABCNews (2020) 

Passion River Productions. (2014). I’m with Phil: A 
town, a tornado and twenty people named 
Phil {Video]. Kanopy. https://
dmacc.kanopy.com  

Parenthetical: (Passion River, 2014) 
Narrative: Passion River (2014) 
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Citation Tools 

What is a Citation Tool?  
Citation tools are software programs designed to perform part or all of the tasks involved in creating academic 
citations. Most tools are capable of at least creating your References page at the end of your paper. Some can also 
assist you with your in-text references. A few can even help you manage and organize your resources. 

 

 

 

 

 

 

Should I Use a Citation Tool? 
 
This is a complicated question. While citation tools 
certainly make the process easier, most individuals 
acknowledge that there is value in learning not only the 
pieces of a written citation, but also how it is 
constructed. 
 
Many DMACC instructors want their students to have 
the opportunity to learn how to construct a written 
citation. These instructors do not allow the use of 
citation tools, and require that students create their 
own citations.  
 
Other instructors, particularly in more advanced 
classes, believe that their students have already gained 
this foundational knowledge of how to construct a 
citation. These instructors typically see the use of 
citation tools as somewhat equivalent to using a 
calculator in a higher level math class. These 
instructors are typically “ok” with the use of a citation 
tool, as long as the student’s References list is 
correctly formatted. 

Can My Instructor Tell If I Used a 
Citation Tool? 
 
This depends a bit upon how the class is formatted. If 
you are simply submitting a final draft of a paper, all 
your instructor will see is whether or not your citations 
are correctly formatted. However, not all citation tools 
are particularly accurate, and instructors can always do 
an in-class test of your citation knowledge and creation 
skills. 
 

How Accurate Are Citation Tools? 
 
This is also a complicated question. Some of the 
citation tools are capable of producing highly accurate, 
detailed citations, provided that the information you 
enter is also accurate. Some citation tools are limited 
in the types and/or complexity of the citations they can 
produce. Many citation tools are poorly programmed 
and are incapable of producing accurate citations.  
 
Ultimately, each student is responsible for the work 
he/she turns in. You should always double check your 
citations for accuracy and completeness.  
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Citation Tools 

Which Citation Tool Should I Use? 
There are literally hundreds, maybe thousands, of 
citation tools available. Many are free; some require 
purchase or an on-going fee. Some tools have less 
powerful (and sometimes less accurate) free versions, 
as well as “upgraded” fee-based versions. Some 
instructors will tell you to use their favorite citation 
tool. In the end, you should use the tool that best 
meets your needs. In addition to helping you create 
citations the “old fashioned” way, the Library is able to 
assist you with both NoodleTools. For assistance with 
other citation tools, you will need to consult with your 
instructor or contact the service directly.  

NoodleTools 
NoodleTools is the preferred citation tool of most 
DMACC researchers. As long as the information entered 
into the NoodleTools form is accurate, the software will 
produce an accurate citation. NoodleTools asks the user 
to complete a form for each resource. These forms are 
then converted into a properly formatted References 
list. While the NoodleTools knowledge base has 
extensive advice and information on how to properly 
construct in-text references, the software itself is only 
capable of producing the References list, which is 
placed at the end of a paper. 
 

Microsoft Word Citation Manager 
Some DMACC users prefer the ease of an integrated 
citation tool, like the Microsoft Citation Manager. The 
data form for recording sources can be clunky, and 
Microsoft doesn’t always follow the rules. This means 
that citations need to be corrected before submitting 
them for a grade. Many students find this process 
confusing and stressful. (A list of required corrections is 
available from the Urban library.)  



Updated: 6/20 30 

 

NoodleTools 

What is NoodleTools?  
NoodleTools is an online tool that can help you format your bibliography page and allows you to save and organize 
the references for books and articles used for your research assignments. It is accessible from home and campus 
through the DMACC library website. For further assistance, contact a DMACC librarian.  

You need to access NoodleTools through the 
DMACC library website. Click on the link for 
“Research Help”. Then, select “Citations”. 

A new tab will open on your screen. Click on 
the icon for NoodleTools. 
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NoodleTools 

If you have never used NoodleTools, you will 
need to “Register” to create an account.  

 

 

 

 

 

 

 

 

 

 

Complete the registration form, create a 
Personal ID (username) and password. You may 
use anything you would like for your username, 
as long as someone else hasn’t already selected 
it. We recommend using your DMACC username 
and password. 

 

 

 

 

 

 

 

 

If you forget your username/password, 
please see your campus librarian.  
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NoodleTools 

Once you have created your Personal ID, you can 
start entering references by creating a new 
project. Each research project you are working 
on should have its own list. Start by clicking on 
the “New Project” button at the top left-hand 
side of the page.  

Next, name your project. Select “APA” for the 
“Citation style” and “Advanced” for the 
“Citation level”. Click “Submit” at the bottom 
of the box to get started.  

  

You may name your project 
anything you like, but we 
recommend that you include the 
topic of your project, the course 
and semester. E.g. Stress 
Management PSY111 Spring 
2017. 
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NoodleTools 

The next screen is called the Dashboard. Here 
you can work on many aspects of your project: 
your thesis statement, your research question(s). 
You can also share your project with a teacher or 
librarian to receive assistance and/or feedback.  

You can set up and maintain a “To Do” list of 
tasks you still need to complete for your project. 
You can use NoodleTools to create digital 
notecards and your outline.  

You will primarily use NoodleTools to create your 
Reference list for your project. You may begin by 
clicking “Sources” at the top of the screen. 

 

 

Once you have clicked on “Sources”, you are 
ready to begin entering the information for each 
of your sources. 

Create a citation for each source by clicking 
“Create New Citation” in the upper left-hand 
corner. 

While NoodleTools provides a link to 
Google Docs, we recommend that you use 
Microsoft Word to write your paper. Word 
is available on all DMACC computers. 
Students can also access Word Online for 
free through their Webmail.  
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NoodleTools 

 
First, select where you located your resource. 
For most DMACC students, this will usually be 
either “Database” or “Website”. 

 

 

 
 

Then, select what the item is. 
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NoodleTools 

 
 

Complete the form with the available 
information for your resource. If you decide you 
have selected the incorrect resource type, you 
may make changes from the drop down boxes at 
the top of the screen. 

 

As you select each text box, NoodleTools 
will give you instructions for the correct 
entry of your data. If you make a 
mistake, NoodleTools will display an 
exclamation point inside of a yellow 
triangle. 
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Once you have clicked on “Submit” to complete a 
resource, NoodleTools will return you to the main 
References screen. To enter another resource, simply 
select the resource type from the drop down and begin 
the process again. 

 Complete the form with the available information for 
your resource. If 

Once you have reached the main References 
screen, your work has already been saved to 
the NoodleTools server. Please do not try to 
save your work to an another source. (e.g. a 
flash drive, your p:\ drive, etc.) 

After you have entered all of your sources and 
completed your paper, review each of your citations on 
the main References page for errors. You can edit your 
citations by clicking the “Options” button on the right-
hand side of the screen. 

NoodleTools 
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NoodleTools 

Finished? Now print your References Page 

 

 

To print your References page, click the “Print/
Export” button and then select “Print/Export to 
Word” 

  

 

 

 

 

 

 

 
 

Once you see the pop-up for Microsoft Word, 
click “Ok”. Your References page will open in a 
new Microsoft Word window. 
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NoodleTools 

NoodleTools will always open your References in 
Times New Roman, 12pt font. Double check and 
make sure that the font matches what’s on the 
rest of your paper. Also, be sure to add a header 
with your name and the correct page number. 
Please see a DMACC librarian if you need help 
with getting the correct page number added. 

Since NoodleTools saves your work to their 
server, and keeps track of any changes to 
your list, we recommend that you wait and 
print your References at the very end of 
your project. This will help eliminate 
confusion and mistakes between what you 
may have saved and what NoodleTools has 
saved.  
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